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Introduction

This document will provide a reference guide that you can turn to if you forget a step that was demonstrated at the RSS seminar.  It is our hope that you’ll use the seminar and this guide to create and publish RSS feeds on your own website.

Reading RSS Feeds with RSSOwl

Step 1: Get RSSOwl

You will find the zip file for RSSOwl at http://internap.dl.sourceforge.net/sourceforge/rssowl/rssowl_1_2_win32_bin.zip .  You can also always download the latest version at http://www.rssowl.org  

Please note, RSSOwl is just one of many non-web-based RSS readers available.  For a good list of RSS readers, visit http://dmoz.org/Reference/Libraries/Library_and_Information_Science/Technical_Services/Cataloguing/Metadata/RDF/Applications/RSS/News_Readers 
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The provided version of RSSOwl requires no installation.  Simply extract the zip file to a location of your choice.  Open the created folder and double-click rssowl.exe to start the program.
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To ensure RSSOwl appears like it does in the screenshots throughout this section, please ensure that, on the view menu, there are checkmarks next to “toolbar”, “quickview”, and “favorites.” 

Step 2: Add Feeds to RSSOwl

Before you can add an RSS feed to RSSOwl, you have to find a feed you’re interested in.  Many websites offer feeds to keep you updated on the newest content being offered.  Find a feed that interests you and copy the URL for the feed.
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Click the “New” button in RSSOwl to begin the process of adding the feed.  
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Tip: If you click the down arrow next to “New” you can select “Category” to create folders for your feeds (similar to how you can create folders in Internet Explorer to organize your bookmarks).
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After clicking “new,” RSSOwl will open a dialog-box that will let you enter information about the feed, as described below.  Once you enter the information, click the “OK” button to add the feed.

[image: image6.jpg]Enter the information for the feed.
This includes:

*The feeds URL (which you can
paste into the field by right-clicking
and selecting paste).

*A title (you can have RSSOw! pull
the tile from the feed, or you can
type one).

«A category (or folder) to hold your
favorite.

*How frequently you would like
RSSOwI to update the feed.
“Whether you would like RSSOwI to
open the feed automatically when
you open RSSOwl.




Step 3: Read the Feed in RSSOwl
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On the right side of RSSOwl, you’ll see a list of your favorites.  Double-click on your newly added feed to open a tab showing the feed’s items.  Unread items will appear in bold.  If you click an item, a more detailed description will appear below.  If the item interests you, you can click the link to open a browser window to access the shown URL.

You can aggregate an entire folder of feeds by right-clicking the folder and selecting “Aggregate favorites.”  In this way, you can see all items from several feeds at once.  You can, for example, open all computer news feeds in one window, instead of having to open each one individually. 
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Creating and Editing RSS Feeds with Firefox’s RSS Editor Extension

Step 1: Get the RSS Editor Extension for Firefox

There are two major ways to create RSS feeds for your website.  One method involves using a content management system to automatically generate feeds using the content already in the system.  The other way is to manually create feeds.  This approach involves manually creating the XML files that represent feeds.  You can do this by hand…but an easier method is to use an editor that will create the required XML structure for you. 

During the seminar, we worked with the RSS Editor extension for the Firefox web browser.  This extension makes it easy to create your own RSS feeds.  You can download Firefox at http://www.mozilla.com/en-US/ .  If you want to use Firefox, but can’t install software on your machine because of security restrictions, you can try using PortableFirefox from http://portableapps.com/apps/internet/firefox_portable .  PortableFirefox installs by just placing all the files needed to run Firefox in the directory of your choice.
No matter how you install Firefox, just visit https://addons.mozilla.org/extensions/moreinfo.php?id=344&application=firefox while in Firefox and click “install now” to install the RSS Editor extension.
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Step 2: Creating a New Feed

To start the RSS Editor, start Firefox as described above, and then access the “Tools” menu.  Select “RSS Editor.”  Finally, choose how you’d like to see the editor.  The screenshots in this section are from the “Float” option.
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[image: image10]
Once the editor is open, select the “File” menu and select “New” to start a new feed.  You can also select “Open” to open an existing feed on your computer, or “Open URL” to open a feed from a website.

Step 3: Setting Up the Channel for the Feed

The channel tab describes your feed.  The information you enter here should describe the contents of the entire feed.  The fields are described below for your reference.
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Step 4: Creating Items in the Feed

After you fill out the channel information, you can click on the items tab to enter information about the items in the feed.  It is by using this tab that you will update your feed by removing old items and adding new items.  Again, a description of what to enter into each field is described below.
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Step 5: Saving Your Feed

Once you create all of the items for your feed, and describe the overall theme for your feed via the channel tab, you’re ready to save your feed for publication to your website.  You do this in the standard way of selecting “Save” from the “File” menu.
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Congratulations!  You are now ready to publish your feed to your website.  Once there, you link to the XML file just like you link to any page on your website.  However, it’s often useful to provide a page describing what RSS feeds are for your users who may not be aware of feeds or how to use them.  And remember:  feeds should be updated on a regular basis!

Testing Your Feeds in RSSOwl

You can test your RSS feeds in RSSOwl before publishing them.  Simply open RSSOwl and selection “File” then “Open.”  Select your feed and it will open in RSSOwl like any other feed.

The picture below shows how the fields in the RSS editor are displayed in RSSOwl.

RSS Editor Channel Information in RSSOwl
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RSS Editor Items in RSSOwl

The image below shows where items appear in RSSOwl.
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The image below show where an item’s details appear in RSSOwl.
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Additional Feed Testing

By reviewing your feed in RSSOwl you can quickly identify problems with content and format.   Taking a few extra steps can also help you ensure that your feed is ready for publishing and promotion.

FEED Validator ( http://www.feedvalidator.org ) is a great tool for validating RSS feeds.  Simply post your feed XML file to your server (it must be a server that can be accessed from outside your firewall) and submit the feed URL to FEED Validator.  The resulting feedback will identify potential problems with your feed.  Note that feeds can be valid but still have problems that prevent them from being optimally consumed by feedreaders and other tools; FEED Validator specifically identifies those problems.

Testing in Bloglines ( http://www.bloglines.com ) can also help you identify tweaks that will optimize your feed.  For example, you can check to ensure that your site’s favicon shows in the feed listing in the navigation pane.  You can also check the feed image you included in the <image> tag of your feed.
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The above example shows a podcast feed; you can Bloglines and other feed readers to test podcasts as well as regular RSS feeds.  When testing a podcast feed you should also subscribe to the podcast via iTunes and test your feed in iTunes to make sure it is optimized properly.  See http://www.apple.com/ilife/tutorials/itunes/it5-1.html for more information on subscribing to a podcast via iTunes.  More information on coding iTunes-friendly podcast feeds appears in the next section.

When testing earlier versions of your feed with external testing or validation services you should use a feed that includes a small number of items with recent publish dates.  This will prevent the services from caching older feed items that may be difficult to remove when you launch the final version of your feed.

Coding Podcast Feeds

Podcast feeds are simply RSS feeds with additional code that specifies links to audio or video files.   The <enclosure /> and <guid> tags link to the media files on your server, for example:

<enclosure length="1836513" url="http://www.yoursite.gov/audio/sample.mp3" type="audio/mpeg"/>

<guid>

 
http://www.yoursite.gov/audio/sample.mp3

</guid>

The enclosure length is the file size of your audio or video file in bytes; you can obtain this by examining the properties of the media file.   Note that the single <enclosure /> tag is self-contained; there is no closing tag.

While addition of the <enclosure> tag is sufficient to transform a plain RSS feed into a podcast, you should also include iTunes-specific tags in your podcast feed.  According to FeedBurner, in April 2006 iTunes accounted for over 50% of podcast subscriptions  so it only makes sense to optimize your feed for iTunes.

You will add code at the <channel> level of your feed that provides information about the feed, and you’ll also add code at the <item> level to provide iTunes with information about each individual podcast episode.  iTunes tags all include the itunes text string; inclusion of these tags will not interfere with consumption of the feed by other feed readers.

One key channel-level tag identifies the category(ies) in which your podcast will be shown in the iTunes Store (ITS).  Users who browse podcasts on ITS will be able to locate your podcast more easily if it has the proper category tags. On the next page is the main Government & Organizations screen on ITS:
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The “standard” tagging for US Federal government podcasts is:

<itunes:category text="Government & Organizations">

<itunes:category text="National"/>

</itunes:category>

You’ll find more information on iTunes podcast coding at

http://www.apple.com/itunes/store/podcaststechspecs.html
Highlighting RSS Feeds In Modern Browsers
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Modern browsers (Firefox 1.5 and up, Opera 8 and up, Internet Explorer 7 and up, etc…) have the ability to highlight the RSS feeds on a site.  For example, Firefox 1.5 displays an icon ([image: image20.jpg]


) to indicate when a site offers RSS feeds.  A user can than click on the icon to show a list of the RSS feeds available and allow them to quickly add a Firefox Live Bookmark for one of the feeds.

So, how do you get these modern browsers to recognize the feeds on your site?  You add the following HTML to the <head> section of each of the web pages on your site:

<link rel="alternate" type="application/rss+xml" title="[title of feed]" href="[URL for feed]">

You can place more than one of these <link> tags on your site if you offer more than one feed.  For example, MSNBC uses the following code to get the effect shown above:

<link rel="alternate" type="application/rss+xml" title="MSNBC - Top Stories" href="http://rss.msnbc.msn.com/id/3032091/device/rss/rss.xml">

<link rel="alternate" type="application/rss+xml" title="MSNBC - Most Viewed" href="http://rss.msnbc.msn.com/id/3058960/displaymode/1026/eventType/1/rss/rss.xml">

Submitting Your Government RSS Feed to FirstGov.gov
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[image: image21]
Once you begin publishing RSS feeds to your Government sites, please let FirstGov.gov know so that your feed can be added to the library of Government feeds available at http://www.usa.gov/Topics/Reference_Shelf/Libraries/RSS_Library.shtml . A library of Government podcast feeds is available at http://www.usa.gov/Topics/Reference_Shelf/Libraries/Podcasts.shtml 

The easiest way to let FirstGov.gov know about your new feed is to use the “Suggest-A-Link” feature that can be found on every page on FirstGov.gov, or accessed at http://www.usa.gov/feedback/SuggestLinkForm.jsp .
Publishing and Managing Your Feeds

Basic Approach

As mentioned above, the simplest way to publish your feed is to copy the XML file to your web server and link to that file from other pages on your site.

Pings

While feed search engines and aggregators check for new versions of feeds at least daily (some check as often as every 30 minutes) you should use ping services to notify readers and aggregators when you’ve published an updated feed.  An initial ping to these services can also notify them when you initially publish the feed, and pings are useful when you want to make a time-sensitive feed item available immediately.

You can notify ping services manually by visiting a site and entering feed URLs or automatically by submitting a ping to the service programmatically whenever a feed is updated.  Of course, automatic notification is really only practical when you generate your feed automatically (e.g., via a content management system).

For regular RSS feeds, you can use services like ping-o-matic ( http://pingomatic.com ) &/or pingoat ( http://pingoat.com ) to easily notify multiple aggregators and search engines.  You can also ping bloglines at http://bloglines.com/ping .

You can use these services to notify search engines and aggregators when you update podcast feeds.  To notify the iTunes Store about podcast updates you should ping iTunes directly.  You’ll find more information on iTunes pings is in the “Adding Episodes” section at 

http://www.apple.com/itunes/store/podcaststechspecs.html
Tracking

Tracking RSS feed statistics is nearly impossible when publishing feeds using the basic approach because subscriber activity is mingled together with activities of search engines and feed aggregators.  For example, while a thousand users might subscribe to your feed via Bloglines they will generally access the version of your feed that is cached on a Bloglines server.  You can’t use traditional log file analysis to determine hits to your feed file.

However, you can use log file analysis tools to track podcast-related media file hits.  Most tools can be configured to track statistics for mp3 and mp4 file types.  Of course, hits to media files generated via the podcast feed become more difficult to measure if you also link to the media files directly from other pages on your site.

While the basic approach offers advantages in terms of simplicity of initial publishing and maintenance of total control over the feed, the downsides to that approach are numerous.  The additional work required to send pings, along with the inability to gather meaningful metrics, suggests that another approach to publishing and managing feeds should be used.

Advanced Approach Using FeedBurner

FeedBurner ( http://www.feedburner.com ) is a commercial feed publishing and management service.  An in-depth discussion of publishing feeds using FeedBurner is beyond the scope of this document.  But a few highlights of the service are worth mentioning.

Pings

When you publish a feed using FeedBurner you can take advantage of the PingShot ping service.  This service automatically pings search engines, aggregators and directories whenever your FeedBurner-published feed is updated.  Once you activate PingShot you will not have to perform any additional steps (manual ping submissions, additional programming) to send pings.

Tracking

As of this writing, publishing feeds through FeedBurner provides the only method to accurately track subscriber activity.  The tracking tools provide information on feed subscriber numbers, aggregator types, and clickthroughs.  This information can be used to measure the reach of your feeds and provide ROI metrics to higher-level decision makers.  On the next page are sample FeedBurner statistics screen shots:
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While it is easy to see the benefits of publishing feeds using FeedBurner you should understand that initial feed publishing can be more complicated and that you will end up relinquishing control of your feeds to some extent.  If you use the standard FeedBurner service, subscribers to your feed will subscribe using a FeedBurner URL (e.g. http://feeds.feedburner.com/yourfeed ) rather than a URL pointing to your government domain.  You can simulate the hosting of your feed on your own domain by using FeedBurner’s MyBrand service (see http://www.feedburner.com/fb/a/publishers/mybrand ), but this requires advanced technical configuration and presents some additional challenges when using a content delivery network such as Akamai.

For a more complete overview of Feedburner services visit

http://www.feedburner.com/fb/a/blogs
and scroll down to the table outlining the different services.

A useful explanation of how FeedBurner works has been posted to the FeedBurner blog at

http://blogs.feedburner.com/feedburner/archives/2006/09/a_peek_inside_techcrunchs_100k.php
Gadgets
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Gadgets are small applications that run on your computer’s desktop all the time. They allow users to get the information they need when they need it.  RSS feeds are a great example...a RSS gadget allows you to view the latest RSS feeds at any time, right from your desktop. 
There are numerous providers of Gadgets (also called Widgets, depending on the provider).  Here’s a list to get you started.


URLs Mentioned in this Reference Guide

(listed in the order in which they were mentioned)

RSSOwl

http://internap.dl.sourceforge.net/sourceforge/rssowl/rssowl_1_2_win32_bin.zip

http://www.rssowl.org 

List of RSS Readers

http://dmoz.org/Reference/Libraries/Library_and_Information_Science/Technical_Services/Cataloguing/Metadata/RDF/Applications/RSS/News_Readers 

Firefox RSS Editor Extension

https://addons.mozilla.org/extensions/moreinfo.php?id=344&application=firefox 

FEED Validator

http://www.feedvalidator.org 

Bloglines

http://www.bloglines.com 

iTunes Podcast Subscription Tutorial

http://www.apple.com/ilife/tutorials/itunes/it5-1.html 

Podcasting and iTunes: Technical Specification

http://www.apple.com/itunes/store/podcaststechspecs.html 

U.S. Government RSS Library

http://www.usa.gov/Topics/Reference_Shelf/Libraries/RSS_Library.shtml 



Podcasts from the U.S. Government

http://www.usa.gov/Topics/Reference_Shelf/Libraries/Podcasts.shtml 



USA.gov Suggest-A-Link

http://www.usa.gov/feedback/SuggestLinkForm.jsp 



ping-o-matic

http://pingomatic.com 

pingoat

http://pingoat.com 

Bloglines ping

http://bloglines.com/ping 

FeedBurner

http://www.feedburner.com 

FeedBurner MyBrand

http://www.feedburner.com/fb/a/publishers/mybrand 

Feedburner Services Overview

http://www.feedburner.com/fb/a/blogs 

A Peek Inside TechCrunch's 100k Subscriber Milestone (FeedBurner Blog post)

http://blogs.feedburner.com/feedburner/archives/2006/09/a_peek_inside_techcrunchs_100k.php
Yahoo Widgets

http://widgets.yahoo.com/
Google Sidebar  (part of Google Desktop search)
http://desktop.google.com/
Windows Sidebar 
http://www.microsoft.com/windows/products/windowsvista/features/details/sidebargadgets.mspx
Apple Dashboard 
http://www.apple.com/macosx/features/dashboard/




Name�
URL�
Platform�
�
Yahoo Widgets�
� HYPERLINK "http://widgets.yahoo.com/" ��http://widgets.yahoo.com/��
Windows XP/Vista, OS X 10.3.9+�
�
Google Sidebar 


(part of Google Desktop search)�
� HYPERLINK "http://desktop.google.com/" ��http://desktop.google.com/��
Windows 2000 SP 3+/ XP/Vista�
�
Windows Sidebar�
� HYPERLINK "http://www.microsoft.com/windows/products/windowsvista/features/details/sidebargadgets.mspx" ��http://www.microsoft.com/windows/products/windowsvista/features/details/sidebargadgets.mspx��
Windows Vista�
�
Apple Dashboard�
� HYPERLINK "http://www.apple.com/macosx/features/dashboard/" ��http://www.apple.com/macosx/features/dashboard/��
OS X 10.3+�
�
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